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Installation:
Starten Sie das Programm setup.exe.

Dieses Programm führt Sie durch den kompletten Installationsvorgang
außerhalb des Venturas und erlaubt Ihnen sogleich mit der Arbeit zu be-
ginnen, sofern Sie nicht die MultiSaveAsPro-Module innerhalb des
Corel Venturas einer Taste oder einem Menuepunkt zuordnen wollen.

Vergleichen Sie hierzu auch:

Corel Ventura Skripte Menues, Buttons und Tasten zuweisen, auf
Seite 28, Corel Ventura 7 auf Seite 28, Corel Ventura 8 auf Seite 32
und Corel Ventura 10 auf Seite 37

Nach der Installation können Sie die Module von MultiSaveAsPro direkt
aus der Schnellstartleiste, dem Desktop oder dem Startmenue aufrufen.

Beispiel für Schnellstartleiste:

Beispiel für Desktop:
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Beispiel Startordner:

Arbeiten mit MultiSaveAsPro

Kurzanleitung:
Publikation Öffnen mit
Publikation Sichern mit

aus der Schnellstartleiste des Window-Explorers
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Ausführliche Anleitung:

Publikationen öffnen

Rufen Sie das Modul MultiSaveAsPro-Open entweder aus dem Ex-
plorer oder dem geöffneten Ventura heraus auf.
Dieses Modul passt sich automatisch der Ausgangssituation an und rea-
giert dehalb unterschiedlich:

Es ist kein Corel Ventura geöffnet:
MultiSaveAsPro erkennt, dass noch kein Corel Ventura geöffnet ist, er-
mittelt automatisch die auf Ihrem Rechner vorhandenen Versionen und
startet ein spezielles Öffnungsfenster:

Sie können jetzt die gewünschte Version auswählen, indem Sie entweder
das Menue öffnen, mit der Maus das gewünschte Symbol auswählen
oder einfach die Tasten 7,8 oder 1 betätigen.

Danach wird der gewünschte Corel Ventura geöffnet und es erscheint
das MultiSaveAsPro-Öffnenfenster.

Es sind bereits ein oder mehrere Corel Ventura(s) geöffnet:
Rufen Sie das Modul MultiSaveAsPro-Open entweder aus dem Ex-
plorer oder dem geöffneten Ventura heraus auf.
MultiSaveAsPro öffnet automatisch das MultiSaveAsPro-Öffnenfens-
ter in dem Corel Ventura, in dem Sie zuletzt gearbeitet haben.
Beachten Sie aber bitte:
Corel Ventura Skripte funktionieren nur aus der zuerst geladenen Instanz
einer Version des Corel Venturas. Arbeiten Sie in einer höheren Instanz
wird MultiSaveAsPro Sie in diesem Fall warnen.
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Beim ersten Start öffnet sich das MultiSaveAsPro-Öffnenfenster mit
dem folgenden Inhalt:

Sie können jetzt mit eine neue Publikation beginnen, oder mit
den Datei-Öffnen-Dialog von Corel Ventura starten.
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Nachdem Sie die ersten Publikationen mit MultiSaveAsPro gespeichert
haben, wird die leere Publikationsliste nach und nach gefüllt.

Inhalt MultiSaveAsPro-Öffnenfenster:

Spalte 1:
Zählt, wie oft eine Datei unter MultiSaveAsPro geöffnet wurde. In der
Standardeinstellung ist die Publikationsliste nach dieser Zahl sortiert,
d.h., die am häufigsten geöffnete Datei steht an erster Stelle.
Sie können die Sortierfolge durch einen Mausklick auf die Kopfzeile einer
Spalte verändern.

Spalte 2:
Enthält den Publikationsnamen. Sollte ein Name in verschiedenen Ver-
zeichnissen vorkommen, wird eine laufende Nummerierung an den Pub-
likationsnamen angehängt.

Spalte 3:
Enthält Datum und Uhrzeit der letzten Sicherung.

(Andere)

Öffnet den normalen Datei-Öffnen-Dialog von Corel Ventura.

(Neu)
Beginnt eine neue Datei

WERNER PERPLIES EDV-ANWENDUNGSBERATUNG

Bedienungsanleitung: MultiSaveAsPro

11 Stand: 26. Januar 2005



(Springe auf Bearbeitungspunkt)
Wenn Sie dieses Feld markiert haben, wird nach dem Öffnen einer mit
MultiSaveAsPro gesicherten Datei die letzte Arbeitsposition beim
Beginn der Sicherung angesprungen.
Beachten Sie bitte die folgenden Einschränkungen:

Im Corel Ventura 7 kann nur die letzte bearbeitete Seite (Seitenanfang)
angesprungen werden.
In einigen Fällen (Rahmen oder Grafikobjekt markiert, Position in Tabelle
u. ä.) kann die Position nicht exakt bestimmt werden. Die Positionierung
erfolgt in diesen Fällen nur ungefähr.

(Automatisch öffnen)

Wenn Sie dieses Feld markiert haben, können Sie die Datei direkt durch
die Eingabe des Namens öffnen.
Sie brauchen dabei nur so viel vom Namen eingeben, bis der Name ein-
deutig bestimmt ist.
In unserem Beispiel:

Die Taste öffnet direkt die Datei Dies ist ein ganz ....

Um die Datei MuPoBedienungsanleitung zu öffnen, müssten Sie den
kompletten Dateinamen eingeben, da der Name bis zu dieser Stelle mit
dem Namen MuPoBedienungsanleitung-(2) identisch ist.

(Einstellungen speichern)
Wenn Sie dieses Feld markieren werden die vorgenommenen Änderun-
gen gespeichert und in Zukunft als Vorgabe verwendet.
Gespeichert werden dabei die Sortierfolge, Automatisch öffnen und
Springe auf Bearbeitungspunkt.
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Kontextmenue
Wenn Sie eine Datei mit der Maus markieren und die rechte Maustaste
betätigen, erscheint ein Kontextmenue:

(Öffnen)
Öffnet die markierte Publikation.

(Eigenschaften)

Öffnet ein Fenster mit den Publikationseigenschaften. Der Inhalt dies
Fensters hängt von der Publikation und Ihren MultiSaveAsPro-Einstel-
lungen ab.

(Sicherungsdateien)
Öffnet ein Fenster mit der Liste der Sicherungsdateien. Eine genaue Be-
schreibung finden Sie unter Eine Publikation wieder herstellen auf
Seite 20.

(Publikation schließen)
Dieser, vielleicht etwas missverständliche Menuepunkt, entfernt eine
Publikation aus der MultiSaveAsPro-Publikationsverwaltung.
Dabei geschieht folgendes:
Die Datei erhält statt Ihres intern verwendeten Namens !9999!Name.vp
ihren ursprünglich Namen Name.vp zurück.
Die MultiSaveAsPro-Einstellungen für diese Publikation werden ge-
löscht.
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Die Publikation wird aus der Datei-Öffnen-Liste entfernt.
Die Publikation und alle Sicherungsdateien bleiben erhalten.
Verwenden Sie diesen Menuepunkt, wenn Sie die Arbeit mit dieser Publi-
kation abgeschlossen haben.

(Abbrechen)
Bricht den MultiSaveAsPro-Öffnen-Vorgang ab.
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Publikation sichern
Publikation Sichern mit

Je nach Ausgangssituation verhält sich das Programm unterschiedlich:

Die erste Sicherung einer Publikation MultiSaveAsPro:
Wenn es sich um eine neue Datei handelt, öffnet sich zuerst das normale
Corel Ventura-Speichern-unter...-Fenster.
Wählen Sie den Speicherplatz (Verzeichnis) und den Dateinamen aus.
Bestätigen Sie den Vorgang.

Danach oder bei einer bereits gespeicherten Publikation öffnet sich das
MultiSaveAsPro-Voreinstellungsfenster:

Die Einstellungen im Einzelnen:
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Anzahl der Sicherungsstufen:

MultiSaveAsPro erzeugt mit jedem Sicherungsvorgang eine Backupda-
tei. Mit dieser Einstellung legen Sie fest, wie viele dieser Sicherungsda-
teien erhalten bleiben sollen, bevor die älteste Sicherungsdatei wieder
überschrieben wird.
So ist es Ihnen möglich, zu jeder Zeit einen älteren Bearbeitungszustand
wieder herzustellen.
Sie können hier minimal eine und maximal 999 Sicherungsstufen ein-
stellen.

Dateinamenpräfix

Mit diesem Eintrag können Sie einen Namensteil festlegen, mit dem der
Name der Backupdatei dieser Publikation beginnen soll.
Sie sollten diesen Eintrag benutzen, wenn Sie alle Datensicherungen in
ein Verzeichnis (nicht empfohlen!) ablegen lassen.

Ausgewähltes Sicherungslaufwerk und Ausgangsverzeichnis

Mit diesem Eintrag legen Sie fest, auf welchem Laufwerk und in welches
Ausgangsverzeichnis die Backupdateien abgelegt werden sollen.
Sie sollten, wenn es möglich ist, für Ihre Datensicherung ein anderes
Laufwerk als das Arbeitslaufwerk Ihrer Publikation verwenden.
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Jede Änderung in diesem Eintrag führt automatisch zu einer Änderung im
Eintrag Pfad für <Name.vp>.
Sie können diesen Eintrag durch direkte Eingabe oder durch den Knopf

auswählen.
Bei der Direkteingabe werden nicht vorhandene Verzeichnisse automa-
tisch eingerichtet, bei Verzeichniswahl können Sie nicht vorhandene
Verzeichnisse direkt einrichten.

Pfad für <Name.vp>

An dieser Stelle legen Sie das Zielverzeichnis für die Backupdateien Ih-
rer Publikation fest.
Das oben festgelegte Laufwerk und Ausgangsverzeichnis wurde hier
übernommen.
Das Programm schlägt Ihnen zusätzlich als Pfad den Publikationspfad
vor.

Beispiel:

Sie haben als Laufwerk und Ausgangsverzeichnis

F:\Corel Ventura Backups\
eingegeben.

Ihre Publikation liegt in

D:\Musavetests\CorelVP7\
Dann schlägt Ihnen das Programm als Zielpfad

F:\Corel Ventura Backups\Musavetests\CorelVP7\
vor.
Wenn Sie in diesem Eintrag nachträglich das Laufwerk ändern wird auch
der Eintrag Ausgewähltes Sicherungslaufwerk und Ausgangsverzeichnis
geändert.
Wenn Sie ein ungültiges Laufwerk eingeben, wird dies automatisch durch
das Publikationslaufwerk ersetzt.
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Textdateien einbetten

Corel Ventura kennt sowohl interne als auch externe Textdateien. So-
wohl interne als auch externe Textdateien sind in der Publikation einge-
bunden.

Der Unterschied besteht darin, dass externe Textdateien beim Öffnen
einer Publikation neu eingelesen werden und den Inhalt der intern ge-
speicherten Dateien ersetzen.
Dies führt zu einer doppelten Menge der gespeicherten Daten und ist nur
so lange sinnvoll, wie sie diese Daten extern verändern wollen oder für
andere Programme benötigen.
MultiSaveAsPro trägt diesem Umstand Rechnung, indem Sie entschei-
den können, ob solche Dateien beim Sichern eingebettet werden sollen.

Externe Textdateien einbetten (permanent nicht ausgewählt)
MultiSaveAsPro teilt Corel Ventura mit, dass externe Dateien beim
Speichern eingebettet werden sollen und setzt nach dem Öffnen der
Publikation diesen Schalter wieder auf Beim Speichern exportieren.
Bitte beachten Sie:
Mit dieser Einstellung werde externe Dateien nur aktualisiert, wenn Sie die
Publikation außerhalb der MultiSaveAsPro-Verwaltung sichern.
Der Vorteil dieser Vorgehensweise besteht darin, dass der Status extern
erhalten bleibt und Sie bei Bedarf jederzeit die Dateien exportieren oder ak-
tualisieren können.

Externe Textdateien einbetten (permanent)
Wenn Sie diesen Schalter setzen, werden externe Dateien dauerhaft ein-
gebettet. Die Information extern geht verloren, der Sicherungsvorgang
beschleunigt sich erheblich, wenn Sie keine weiteren externen Dateien
sichern.
Der Schalter externe Textdateien einbetten ist nur freigeschaltet, wenn
Sie den Schalter externe Textdateien sichern nicht gesetzt haben.
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Externe Dateien

Im Gegensatz zu Corel Ventura kann MultiSaveAsPro auch externe Da-
teien sichern. Sie steuern das durch die oben abgebildeten Schalter.

Beachten Sie bitte, dass das Setzen dieser Schalter den Zeitbedarf für
das Speichern erheblich erhöht.
Wenn Sie den Schalter externe Textdateien sichern setzen, wird der
Schalter externe Textdateien einbetten gesperrt.

(Voreinstellungen speichern)
Diese Funktion dient dazu, die gewählten Einstellungen für andere Publi-
kationen zu speichern.
Sie benötigen ihn nicht, um die Einstellungen für diese Publikation zu
speichern.

(Ok)
Mit Ok beenden Sie Ihre Eingaben und lösen den ersten Speichervor-
gang innerhalb der MultiSaveAsPro-Verwaltung aus.

Spätere Änderungen der Einstellungen vornehmen
Normalerweise werden Sie das Einstellungsfenster für diese Publikation
nicht mehr benötigen.
Sollten Sie allerdings in Ausnahmefällen doch Veränderungen der Ein-
stellungen vornehmen wollen, verwenden Sie bitte zum Speichern das
Modul MultiSaveAsPro-Init .
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Eine Publikation wieder herstellen
Schließen Sie alle Publikationen im gewünschten Corel Ventura, oder
öffnen Sie den gewünschten Corel Ventura.
Öffnen Sie MultiSaveAsPro-Open .

Wählen Sie die Publikation, die Sie wieder herstellen möchten.
Drücken Sie die rechte Maustaste, wählen Sie Sicherungsdateien.

Sie erhalten jetzt eine Liste mit allen zur Verfügung stehenden
Backup-Dateien:
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(Öffnen)
Mit diesem Knopf oder aus dem Kontextmenue heraus können Sie Back-
updateien der gerade ausgewählten Publikation öffnen:

(Andere)

Mit diesem Knopf oder aus dem Kontextmenue heraus können Sie Backup-
dateien öffnen, die nicht mehr unter MulitSaveAsPro-Verwaltung stehen.

Beachten Sie aber bitte:

MultiSaveAsPro kann nur eigene Zip-Dateien rücksichern.

Bedeutung der wichtigsten Spalten:
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(DT) Datentyp
MultiSaveAsPro unterscheidet in dieser Liste vier verschiedene
Dateitypen:

0. Publikation
1. Textdateien
2. Bilddateien

3. Voreinstellungsdatei von MultiSaveAsPro-Save.
Dieser Datei kommt beim Rücksichern eine besondere Bedeutung zu,
sie wird immer mit eingelesen, teilweise ausgewertet (Arbeitsposi-
tion), aber nur wirklich rückgesichert, wenn Sie am gleichen Platz rück-
sichern.

(vorh) vorhanden
Diese Spalte gibt an, ob eine Datei an dem Ort, von dem sie gesichert
wurde, noch vorhanden ist.

Pfad

In dieser Spalte finden Sie das Verzeichnis, aus dem die entsprechende
Datei gesichert wurde.
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Rücksicherung von Dateien

Einstellungsmöglichkeiten

Auswahl der Dateien

Wählen Sie die rückzusichernden einzeln mit der Maus aus, oder markie-
ren Sie durch Verwendung des Knopfes alle Dateien.
Sie können aber auch mit der Maus mehrere Dateien auswählen, die
Sie nicht rücksichern wollen und diese Auswahl dann mit dem Knopf

umkehren. Dies ist der schnellste Weg, wenn Sie über die
Hälfte aller Dateien rücksichern wollen.

Ziel der Rücksicherung
In der Standardeinstellung werden alle Dateien am ursprünglichen
Ort zurückgesichert.
Wenn die gleiche Datei schon vorhanden ist, wird Sie das Programm
fragen, ob die Datei überschrieben werden darf, verneinen Sie diese
Frage, wird das Programm Sie bitten, einen anderen Zielordner anzu-
geben.

Geben sie keinen neuen Zielordner an, wird die ausgewählte Datei
nicht zurückgesichert.

(nach Zielordner fragen)

Wenn Sie dieses Eingabefeld markieren, wird Sie das Programm vor
Beginn der Rücksicherung nach einem neuen Zielordner für die
Publikation fragen.
Für den Fall, dass das die Rücksicherungsdatei auch externe Dateien
enthält, wird es bei jedem Verzeichniswechsel auf ein noch unbe-
kanntes Verzeichnis erneut nach einem Zielordner fragen.
Sie können in diesem Fall ein neues, oder auch ein bereits verwendetes
Verzeichnis auswählen.

(vorhandene überschreiben)
Normalerweise prüft das Programm vor der Rücksicherung einzelner Da-
teien, ob eine Datei auf dem angegebenen Ziel bereits vorhanden ist. Ist
solch eine Datei vorhanden, gibt es einen Warnhinweis. Erlauben Sie
das Überschreiben in diesem Fall nicht, wird nach einem neuen Zielord-
ner gefragt.
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Wenn Sie markieren, werden vorhandene Dateien ohne
weitere Rückfrage überschrieben.

Neuordnung der Verzeichnisstruktur Ihrer Publikation
Mit den hier beschriebenen Einstellungen können Sie auch die Verzeich-
nisstruktur komplett neu organisieren:

Voraussetzung:
Alle Dateien müssen noch in Ihren Zielordnern vorhanden sein.

Rücksichern: alle
Vorhandene überschreiben: nicht markieren
Dateien wiederherstellen

Geben Sie jetzt für jede abgefragte Datei einen neuen Zielordner ein.

(Wiederherstellung)
Mit diesem Knopf wird der eigentliche Rücksicherungsvorgang ausge-
löst.

Nach Abschluss wird die rückgesicherte Publikation geöffnet, und
wenn Sie das Öffnungsmenue entsprechend eingestellt haben, die letzte
Arbeitsposition in der wiederhergestellten Publikation angesprungen.
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Weitere Informationen über MultiSaveAsPro

Die MultiSaveAsPro-Installation:

Hier liegen Programmmodule für alle Benutzer des
Systems

Unterhalb dieses Ordners liegen die gemeinsam Datenver-
zeichnisse für alle Benutzer, getrennt nach den Corel Ventura Versionen.
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MultiSaveAsPro-Dateien für jeden Benutzer

(logdat)

Dieses Verzeichnis enthält bis zu 9 Protokolldateien des Programmes
MultiSaveAsPro.

(progdat)
Enthält die Voreinstellungsdateien für MultiSavesAsPro-Save und Mul-
tiSaveAsPro-Open, sowie die MultiSaveAsPro-Ini-Vorlagendatei.
Außerdem zeitweise eine Semaphore-Datei (Signaldatei) mit der En-
dung run, die normalerweise signalisiert, dass ein MultiSaveAsPro-
Modul aktiv ist.

In seltenen Ausnahmefällen kann es geschehen, dass solch eine Datei
nach Beendigung nicht gelöscht wurde. Sofern Sie innerhalb von fünf Mi-
nuten das entsprechende MultiSaveAsPro-Module erneut aufrufen, er-
halten Sie die Meldung, dass das Modul bereits aktiv ist und der neu ge-
startete Programmlauf wird beendet.

Sie können in solch einem Fall die Semaphore-Datei problemlos löschen.
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(pubdat)
Enthält die MultiSaveAsPro-Save-Ini-Dateien für jede verwaltete Publi-
kation.

(temp)

Enthält vorübergehend programmspezifische temporäre Dateien.

(vppublists)
Enthält bis zu neun Versionen MultiSaveAsPro-Open Dateiöffnungsliste.
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Corel Ventura Skripte Menues, Buttons und Tasten
zuweisen

Corel Ventura 7

Da mir Corel Ventura 7 nur in der internationalen Version zur Verfügung
steht, sind die Beispiele Englisch.

Wählen Sie Tools->Customize:
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Ein Corel-Skript einem Menuepunkt zuordnen
Wählen Sie Menu
Wählen Sie im Commands Window

-> Ventura Scripts->___Musavesave.csc
Wählen Sie im Menu Window
Main Menu -> &File->&Save

Drücken Sie die rechte Maustaste
Wählen Sie Rename
Ersetzen Sie &Save durch CD-Save
Schließen Sie die Eingabe durch Anklicken des Symbols vor CD-Save ab

Klicken Sie auf den Knopf Add
Ersetzen Sie ___musavesave.csc durch MultiSaveAsPro-&Speichern.
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Ein Corel-Skript einer Taste zuordnen
Wählen Sie Keyboard
Wählen Sie im Commands Window

-> Ventura Scripts->___Musavesave.csc
Wählen Sie das Eingabefenster Press new shortcut key:
Drücken Sie die Tasten Strg+S

Klicken Sie auf den Knopf Assign
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Ein Corel-Skript einem Toolbar Button (Werkzeugleistenknopf)
zuordnen
Wählen Sie Toolbars

Wählen Sie im Command categories Window
-> Ventura Scripts->___Musavesave.csc
Wählen Sie eines der angebotenen Icons, drücken Sie die rechte
Maustaste und schieben Sie das Icon auf den gewünschten Platz.
Bestätigen Sie alle Ihre Eingaben mit Ok.
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Corel Ventura 8

Ein Corel-Skript einem Menuepunkt zuordnen
Wählen Sie Extras->Optionen

Wählen Sie, wie in der Grafik,
Arbeitsbereich ->Anpassen->Menüs

im Fenster Befehle: ->VENTURA Scripts
im Fenster Menü: -> Hauptmenü->Datei->Speichern

&Speichern umbenennen in &VP-Speichern
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Doppelclick auf Knopf Hinzufügen

Als neuen Menuepunkt MultiSaveAsPro-Speichern eintragen.
Mit Ok bestätigen.

Ergebnis:
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Ein Corel-Skript einer Taste zuordnen
Arbeitsbereich -> Anpassen->Tastaturbefehle
im Fenster Befehle: -> VENTURA Scripts-___musave-save.csc

im Fenster Neuen Tastaturbefehl drücken: Strg+S drücken
Konflikte löschen markieren
Zuweisen
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Ein Corel-Skript einem Toolbar Button (Werkzeugleistenknopf)
zuordnen
Arbeitsbereich -> Anpassen -> Symbolleisten

im Fenster Befehle: -> VENTURA Scripts -> ___multisaveas-save
mit der Maus ein Symbol (zum Beispiel den Pinguin) auswählen und
dieses Symbol bei gedrückter rechter Maustaste außerhalb des Optio-
nenfensters in die Ziel-Symbolleiste schieben.

Das Symbol anwählen und die rechte Maustaste drücken, es sollte
das Menue Eigenschaften erscheinen.
Falls dies nicht beim ersten Mal klappt, versuchen Sie es erneut. Nach
mir nicht ersichtlichen Kriterien klappte es irgendwann.

Bestätigen Sie dieses Menue.
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Öffnen Sie ein beliebiges Programm, das das Windows-Iconformat im-
portieren kann.
Laden Sie die Datei mit dem gewünschten Icon aus dem MultiSaveAsPro-
Programmordner (.ico).
Selektieren Sie das Icon und kopieren Sie es in die Zwischenablage.

Gehen Sie wieder in den Ventura in das folgende Fenster:

Gehen auf die Grafik, drücken Sie die rechte Maustaste und wählen
Sie einfügen.

Bestätigen Sie das Fenster mit Ok.
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Corel Ventura 10
Da mir Corel Ventura 10 nur in der internationalen Version zur Verfügung
steht, sind die Beispiele Englisch. Sie sollten aber mit Hilfe der Bild-
schirmabbildungen die notwendigen Anpassungen auch in der deut-
schen Version vornehmen können.

Wählen Sie Tools->Options

Wählen Sie Workspace->Customize->Commands
Wählen Sie Corel Ventura Scripts->___muSaveSave
Wählen Sie jetzt Appearence

Ersetzen Sie jetzt im Eingabefeld Caption ___muSaveSave durch
MultiSaveAsPro-Save
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Wählen Sie jetzt den Knopf
Wählen Sie jetzt den Knopf

Wählen Sie im MultiSaveAsPro-Programmverzeichnis die Datei
MuSave32.ico aus und bestätigen Sie mit
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Jetzt sollte Ihr Options-Fenster so aussehen:

Ersetzen Sie im Fenster ToolTip Help ___muSaveSave durch
MultiSaveAsPro-Save
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Ein Corel-Skript einem Menuepunkt zuordnen
Schieben Sie jetzt mit gedrückter rechter Maustaste den Eintrag
MultiSaveAsPro-Save aus dem mittleren Fenster an den gewünschten
Platz im Menue (File, unterhalb von Save)

Ein Corel-Skript einem Toolbar Button (Werkzeugleistenknopf)
zuordnen
Schieben Sie jetzt mit gedrückter rechter Maustaste den Eintrag
MultiSaveAsPro-Save aus dem mittleren Fenster an den gewünschten
Platz in der Werkzeugleiste (rechts neben das Diskettensymbol)
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Ein Corel-Skript einer Taste zuordnen
Wählen Sie jetzt Shortcut Keys
Geben Sie in das Eingabefeld New Shortcut Key Strg+S ein.

Bestätigen Sie Ihre Eingabe mit

Jetzt sollte Ihr Options-Fenster so aussehen:

Weisen Sie die anderen Skripte auf die gleiche Art zu und schließen Sie
das Optionen-Fenster.
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